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Kurzweil 3000+firefly  

Using the Universal Library 
About the Universal Library 
Revised:  September 22, 2017. 

The Universal Library is a collection of electronic files that the district, school, teachers and students 
want to store and/or share.  Users can access the Universal Library from any k3000+firefly client over 
the Internet.  

School administrators can upload curriculum material for district- or school-wide distribution, so 
teachers and students can go to a central location to retrieve documents they need. Teachers can post 
class work, assignments, extra-curricular reading material for their students to access; they can also 
share documents and templates with other teachers. Students can upload documents from the 
Universal Library, from their hard disks, from Google Docs, and Bookshare. Additionally they can create 
and edit documents using the k3000+firefly Editor features (see Using the k3000+firefly Editor). 

Currently, the Universal Library supports the following formats: KES, TXT, DOC, DOCX, RTF, EPUB, BKS, 
PDF, JPG, JPEG, and PNG files.  

How the Universal Library is Organized. 
The structure of the Universal Library is based on a user and sub-user file system concept where each 
authorized user can set up and manage his or her sub-users. 

In addition to sub-user folders, each user also has a Public folder and a Private folder. All users have 
Read-Write permission to their own and to sub-users’ Public and Private Folders. 

Sub-users only have Read access to the Public folder of the user who created their account. 

About Folder and File Icon Colors. 
The colors of k3000+firefly folders and file icons help identify their type and ownership. This chart shows 
the color of each folder type. File icons have the same color as the folder in which they reside. Your 
folder color is always yellow. This is true whether you are a Top Level Coordinator (TLC), a Site Level 
/Team Coordinator (SLC), or a Team Member. 

 

Note that the colors in the Universal Library list 
denote rank, but the folder color can change 
depending on the place in the user list. The user 
at the top (You) is always yellow. If You have 
sub-users (as in the case of TLC and SLC), those 
folders beneath you may be orange, indicating 
sub-users (often Team Members). 
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The folders displayed in the Universal Library are arranged below the logged in user by rank, (1) Top 
Level Coordinator (TLC), (2) Site Level/Team Coordinator (SLC), and (3) their sub-users. Note that in 
some cases, the sub-user may be a SLC /Team Coordinator, and in those cases, the color of their folders 
will be orange, not purple (see Example 3). 

In Example 1, the user logged in is a Biology Student Team Member (yellow folder). The KESDistrict is the 
TLC (Red folder), and the Biology Teacher (SLC/Team Coordinator) purple folder. The blue folders 
contain files that can be shared by everyone.  

In Example 2, the Biology Teacher (SLC/Team Coordinator) is logged in (yellow folder), the KESDistrict is 
the TLC (Red folder), and the Biology Student (orange) is managed by the Biology Teacher. The blue 
folders contain files that can be shared by everyone. 

 
Example 1 

 
Example 2 
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Example 3 
 

In Example 3, the KESDistrict (TLC) is logged in 
(Yellow folder) and the orange folders are the 
sub-users the TLC manages, including SLC/Team 
Coordinators and Team Members managed by 
the TLC. 
 
 

Shared Collections. 
The Universal Library contains electronic files that are accessible and shareable. Those folders are blue. 
The following collections are shared: 

• Classic Literature, a collection of nearly 2000 books, historical documents selected from the 
public domain. 

• Samples, files from Cambium Learning Group's published educational series, LANGUAGE! Live. 
• Learning A-Z and Passport Reading Journeys. 
• Nonfiction Bookbag with inspiring content for Grade Levels 3-8. 
• Templates (Brainstorm for Higher Ed, K12 and Teachers).  
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Populating Your Universal Library.  
Logging in takes you to the Universal Library, in your directory, containing your Public and Private 
folders.  

 

In addition to reading books from the shared collections, you can add files to your own folders for 
reading and editing. k3000+firefly supports KES, TXT, DOC, DOCX, RTF, EPUB, BKS, PDF, JPG, JPEG, and 
PNG files. You can also open files from other sources for reading and editing. Notice the four buttons, 
Google Drive, Bookshare, Computer, and Upload. 

• Google Drive allows you to log in to your Google Drive, select documents from your Google 
Drive, and open in k3000+firefly to read. See Opening Local Files from Your Google Drive.  

• Bookshare allows you to search for books in the Bookshare library and open in k3000+firefly to 
read. You can search by Author or by Title.  See Opening Books from Bookshare. 

• Computer allows you to open a local file from your computer. See Opening Local Files from Your 
Computer. 

• Upload allows you to upload files to any folder that you have Read/Write access to. See 
Uploading Files to Your Universal Library. 
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Opening Files in the k3000+firefly Reader.  
k3000+firefly opens these file types for reading:  DOC, DOCX, RTF, EPUB, BKS, PDF, TXT, JPG, JPEG, PNG, 
and KES image files. (See Using the k3000+firefly Reader for details.)  

 

k3000+firefly editing buttons are added to the k3000+firefly Reader for these file types: DOC, DOCX, 
RTF, TXT, as well as KES typed files created in Kurzweil 3000 or k3000+firefly. You will see the Editor 
buttons beneath the Reader buttons that allow you to make edits to the document. Use these buttons 
for editing existing documents and writing new documents that you create using the New Draft button. 
See Using the k3000+firefly Editor, and Creating a New Draft for details. Note that for these file types 
the Reader buttons include a Save button, and do not include the Zoom or Notes buttons. 

 

TXT files are also opened in the k3000+firefly Editor. Note that the Reader buttons include a Save 
button, and do not include Zoom, Highlight, or Notes buttons. The only edit buttons are the Undo and 
Redo buttons. 

 

Reopening a previously opened document. 
When you close a document, the next time you open that document, k3000+firefly remembers where 
you left off and will open at that page. This will automatically occur for the last three documents that 
you read. 
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Returning to Your Universal Library Page. 
After you have opened a document and you want to return to your list of documents, the Library button 
in the k3000+firefly Navigation drop-down menu takes you back to your Universal Library page. 

 

Opening Local Files from Your Google Drive. 
If you have files in your Google Drive that aren’t in the Universal Library, you can open those files in the 
k3000+firefly Reader.  

1. Log in and click the Google Drive button. (Note that you can also log out of Google Drive by 
clicking the link beneath the Google Drive button.) 

 

2. If you aren’t already logged into your Google account, log in using the Google Login pop-up 
window that opens. 

Note: most web browsers include a feature to block pop-up windows. You may need to allow 
pop-ups in your browser to access Google Drive from k3000+firefly. 

3. Your Google Drive opens a Select a file window. If you have organized your files in folders, you 
will see your folders. Open the folder that contains the file that you want to open. 
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4. Select the file that you want to open and click the Select button. The file opens in the 
k3000+firefly Editor.  

5. If you close a file and want to reopen it, you will find it in the recently_opened_local_files 
folder. 

Note: If you want to save changes to a file you have opened from Google Drive, although you cannot 
save it directly to Google Drive, you can save it to the Universal Library. You will then find it in the 
recently_opened_local_files folder. From there you can select it and move it to another folder or copy it 
to your Google Drive. 

Copy a File to Google Drive. 
You can copy files from your Library to your Google Drive. 

1. Select the file in your Library that you want to copy by clicking the checkbox to the left of the file 
name. 

 

2. From the Copy drop-down menu, select Copy to Google Drive. 
3. If you aren’t already logged into your Google account, log in using the Google Login pop-up 

window that opens. 
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Note: most web browsers include a feature to block pop-up windows. You may need to allow 
pop-ups in your browser to access Google Drive from k3000+firefly. 

4. In the Copy to Google Drive window, click Paste. (Note: If you have folders, first navigate to the 
folder into which you want to copy the file.  

 

Opening Books from Bookshare. 
k3000+firefly allows you to search for books to read from the Bookshare library. If the books include 
images, you can choose to load with or without the images. 

1. Click the Bookshare button.  

 

2. A search dialog is displayed. You can search by Author, Title or ISBN. You can also specify to 
search for Free Books Only. 
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3. Enter an Author’s last name or the Title of a book or the ISBN and click Search. (In this example, 
the search is by Author.)  

The Search Results window is displayed. Books that have images and books that are free are 
noted by checkmarks in the columns on the right side of the Search Results window. 

 

4. Make a selection from the list. A dialog is displayed allowing you to choose whether to Load 
With Images or Load Without Images. 

 

5. Click the Loading option that you want. 

6. If it is a free book, and without images, you will get a message that the book is loading. If the 
book is long, it may take some time to open in the k3000+firefly Reader.  
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7. If the book is not free, or is a book with images, you will be prompted for your Bookshare login 
credentials.  

 

8. Enter your Username and Password. If the credentials are correct, the book will open in the 
k3000+firefly Reader. If the book is long, it may take some time to open. 

Note: You will only have to enter your Bookshare credentials the first time you use this feature. 
Your Bookshare credentials will be saved in your k3000+firefly Account.  

9. If you close a book and want to reopen it later, you will find it in the 
recently_opened_local_files folder. 

10. Use the link beneath the Bookshare button to log out of Bookshare. 

See https://www.bookshare.org/ for information about Bookshare. 

Opening Local Files from Your Computer. 
You may have files on your computer that aren’t in the Universal Library. You can open those files in the 
k3000+firefly Reader. k3000+firefly supports several file formats: KES, TXT, DOC, DOCX, RTF, EPUB, BKS, 
PDF, JPG, JPEG, and PNG files. 

1. Log in and click the Computer button. 

 

The File Upload window opens.  

2. Navigate to the file on your computer that you want to open and click Open. The file opens in 
the k3000+firefly Reader. 

3. If you close a file and want to reopen it, you will find it in the recently_opened_local_files 
folder. 

https://www.bookshare.org/
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Uploading Files to Your Universal Library. 
k3000+firefly can upload KES, TXT, DOC, DOCX, RTF, EPUB, BKS, JPG, JPEG, PNG, and PDF files to any 
folder where you have Write Access. 

1. Navigate to a folder where you have Write Access. The Upload button is enabled.  

 

2. Click the button. A Select file window appears which lets you navigate to the folder containing 
your files.  

 

3. Highlight the file you want to upload, and click Open. The file is uploaded to your k3000+firefly 
folder. 

4. You can then open the file in the k3000+firefly Reader. 
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Organizing Your Universal Library. 
You can add and delete folders that you have Write access to in your Universal Library.  

Adding a Folder. 
1. Right click on one of your folders. A menu pops up that allows you to Add and/or Delete a 

folder. (If you haven’t already created any folders, the Delete folder and Rename folder options 
will be grayed out.) 

 

2. Click Add folder. A folder name dialog is displayed. 

 

3. Enter a folder name. If there is more than one word in the name, separate the words with an 
underscore character, as in recently_opened_local_files. 

4. Click the Create button. 
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Renaming a Folder. 
1. Right click on the folder that you want to rename. The folder options menu pops up. 

 

2. Click Rename folder. The Rename dialog pops up showing the current name in the Header. 

 
 

3. Enter a new name in the Folder name field, and then click Rename.  

Deleting a Folder. 
1. Right click on the folder that you want to delete. The folder options menu pops up. 

 

2. Click Delete folder. A warning message is displayed. 
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3. Click Delete if you are sure that you want to delete the folder and all of its contents. 

Copying Files. 
You can copy files from another folder to one of your folders or to public folders or folders that you have 
write access to. If you are a Teacher or SLC, you can also Copy to Multiple Destinations. 

1. Click the box to the left of the file you want to copy. A check mark is displayed in the box. (Click 
Select All to copy all the files in the folder to another folder.) 

 

2. To Copy to a single Destination, from the Copy drop-down menu select Copy. A window 
displaying the folders pops up. Navigate to the folder you want to copy the file or files to.  
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3. Click the Paste button. 
4. A message will pop up telling you whether the copy was successful. 

To Copy to Multiple Destinations. 
If you are a Teacher or SLC, you can copy a file to multiple destinations. This is useful for distributing 
assignments and tests to students. 

1. Click the box to the left of the file you want to copy. A check mark is displayed in the box. (Note: 
you can only select one file at a time to copy to multiple destinations.) 

2. From the Copy drop-down menu select Copy to Multiple. The Copy to Multiple Destinations 
dialog is displayed. 

 

3. You can expand the tree and select users or folders to copy to. (Note: If you have selected users 
or folders in the Destinations area, you cannot also select Copy to All Students' Private Folder in 
the checkboxes below.) 

4. Check any checkboxes: 
• Create New Folder: creates a new folder for the copied file. 
• Copy to All Students' Private Folder: the document will be placed in the private folder of all 

students on your team. If Create New Folder was checked, the document will be placed in a 
new folder in the student's private folder. Note: Do not check this box if you have already 
selected users or folders to copy to in the Destinations section at the top of the window. 
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If you select Copy to All Students Private Folders, a list of your students replaces the users 
and folders displayed at the top of the window in the Destinations area. 

• Overwrite Existing File: if a document with the same filename already exists, it can be 
replaced with a new copy. 

• Prepend Filename With User Name: Your user name will automatically be added to the 
beginning of the filename.  

5. Select an Annotation Source. Annotations that are copied can include: notes, highlights, circles, 
cross-outs, and bookmarks. 
• Owner: The author of the document. User who created annotations in the desktop client 

and saved the file to the Universal Library. 
• Logged In User: The user, who is trying to copy file (e.g. Teacher can copy file from TLC’s or 

other teacher’s public folder to student’s folder). 
• Destination: Copy the file, but do not override annotations (e.g. Overwrite existing file 

from target user). 
6. Click Copy to complete the task. 

Note: See Copy a File to Google Drive for details about copying files to Google Drive. 

Moving Files. 
You can move files from one of your folders to another.  

1. Click the box to the left of the file you want to move. A check mark is displayed in the box. (Click 
Select All to move all the files in the folder to another folder.) 

 

2. Click Move. A window displaying the folders pops up. 
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3. Select the folder to move the file (or files) into then click Move. A popup message will tell you if 
the move was successful. 

Note: You can only move files to and from folders that you have write access to. 

Renaming a File. 
To rename a file in one of your folders: 

1. Click the box to the left of the file you want to rename. A check mark is displayed in the box. 

 

2. Click Rename. The Rename dialog pops up showing the current name in the Header. 
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3. Enter a new name in the File name field, and then click Rename.  

Deleting Files. 
To delete files from one of your folders: 

1. Click the box to the left of the file you want to delete. A check mark is displayed in the box 
(Check Select All to delete all the files in the folder). 

 

2. Click the Delete button. You will be asked if you are sure you want to delete the file (or files). 
Click Yes to delete; click No if you changed your mind. 

Note: You can only delete files from folders that you have write access to. 

Using the k3000+firefly Reader. 
Navigate to the folder that contains the document you want to open. Click the document name to open 
it. Note that the check box preceding the document name is used only to select it for copying, moving, 
or deleting. 

If the Document is Password Protected. 
If a password has been added to a file in k3000, you will be prompted to enter the password before the 
document is opened. 
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After entering the correct password, the document opens.  

If the Document has been Zone Edited in Kurzweil 3000. 

Secondary Zones. 
Secondary zones created in Kurzweil 3000 Web License Edition for Windows and Macintosh are 
recognized in k3000+firefly. Secondary Zones are displayed but not read. This is useful for sidebars and 
other information that are secondary to the main text. The zone can be read aloud if the user clicks in 
the secondary zone area.  

For information about setting Secondary mode in zone editing, refer to the k3000 online help topic: 
Setting Zone Properties. 

Silent Zones. 
Silent zones created in Kurzweil 3000 Web License Edition for Windows are recognized in k3000+firefly. 
You will see the reading highlights, but the voice is not heard.  

This feature is useful in test taking. For information about setting Silent mode in zone editing, refer to 
the Kurzweil 3000 Web License Edition for Windows online help topic: “Setting Zone Properties.”  
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The k3000+firefly Reader Toolbar. 
When the document opens, the k3000+firefly Reader toolbar appears at the top of the open document, 
containing buttons and drop-down menus. The buttons shown will depend on the type of document. 
The buttons shown below are for documents that can’t be edited – PDF, EPUB, BKS, JPG, JPEG, PNG, and 
KES image files. 
 

 

They are: 

1.     Main menu.  
2.     Audio Options menu.  
3.     Bookmark button.  
4-6.  Reading Navigation buttons. 
7.     Audible Reading toggle. 
8.     Highlight menu.  
9.     Document View menu. 
10.   Document Notes menu.  
11.   References menu. 
12.   Tools menu. 
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Main Drop-down Menu. 
The Main drop-down menu lets you move to Your Universal Library, Your Account destinations, and the 
Help topics. 
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Changing the Reading Settings. 
To change reading settings, click the Audio Options button. The settings you choose are saved as your 
preferences.  

 

Set options for: 

• Voice: Use the drop-down menu to select a voice. 
• Reading Speed: Faster, Slower. 
• Skip Reading Headers/Footers: Toggle checkmark On/Off. 
• Unit: Word, Line, Sentence, and Paragraph. 
• Mode: Continuous, Self-Paced, and Word-by-Word. 
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Viewing Image Documents.  
Image Documents can be viewed as a series of thumbnails for easy selection of a page to open. You can 
also specify the zoom level of a document, rotate pages within the document and display Bookmarks 
and Bubble notes. 

 

Thumbnail View. 
The thumbnail view allows you to see a small image of each page. This makes it easy to quickly and 
visually identify pages that you want to open.  

1. To view the thumbnails of an image document you have opened, just click Thumbnail View on 
the Document View drop-down menu. 

Note: If the document is long, or if this is the first time you have opened the document, some of 
the thumbnail images may display slowly. If there are thumbnail images that don’t display, just 
click Thumbnail View again and those pages should display. You can also open the longer 
document in Kurzweil 3000 and break the document into smaller parts, perhaps by chapter, 
using the Save Page Range feature. Then re-save the smaller document(s) to the universal 
library. 
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2. To open a page, just click the thumbnail of the page you want to open. For example, you may 
want to go directly to the first page of a particular chapter. The page opens and replaces the 
thumbnail view. 
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Document Zoom. 
1. To change the zoom setting of an open image document, click the Zoom button. (Note that 

Document Zoom is grayed out (not available) while the document is in thumbnail view, but is 
enabled after a page is opened and the thumbnail view closes.) 

 

2. Choose a range from 25% to 300% or check the Fit to Width option to fit the document to the 
browser window width. Note that the Zoom menu is not available for documents that can be 
edited. 

Rotating a Page. 
The orientation of an image document page opened in the Reader can be changed with the Rotate Page 
feature. 

1. With the page open that needs rotating, open the View menu.  

2. Click Rotate Page Right, Rotate Page Left or Flip Page depending on how you want to orient the 
page. 

The page orientation will be automatically saved and is visible when the document is opened in 
k3000+firefly, Kurzweil 3000 Windows and Macintosh, and firefly for the iPad. 
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Changing the Background Color of a Document. 
When viewing documents in the Reader, you can select a background color from the Tools menu in 
which to view the document. The selected background color view is saved as a preference and seen 
wherever the user logs into k3000+firefly. 

 

Notes: 

• With some browsers if Windows high contrast display themes are being used, the background 
colors cannot be changed. 

• This is a color used to 'view' a document.  The actual color of the document is not changed, for 
example it will print with a white background.  

• The background color for viewing documents in the Reader can differ from the color being used 
in the Editor. 

• If you select Gray, Slate, or Granite as a background color, it’s best to choose a contrasting color 
if using highlighting. Otherwise it may appear that the highlighting is missing. 
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Using Bookmarks in Image Documents. 
The Bookmarks feature in image documents allows you to Add Bookmarks, View Bookmarks, Go to 
Bookmarked text, and Delete Bookmarks. You can also extract bookmarks along with notes and 
highlights. 

 

1. Click the Bookmark button.  The Bookmarks window displays and existing bookmarks are 
displayed. 

 

2. Under List Bookmarks in, select the order in which to sort the bookmarks: 
• Alphabetical order. 
• Reading order.  

Reading order is the order in which the bookmarks appear in the document. 

3. To add a Bookmark, select the text in the image file that you want bookmarked, then click the 
Add button. The Bookmark is added to the list and the Bookmark window is closed. 

4. To hear a Bookmark read out loud, click the Bookmark Button, select a Bookmark in the list and 
it will be read out loud. Click Ok to close the Bookmark window. 



 
k3000+firefly Using the Universal Library       Page 28 of 78 
                
 

5. To go to a Bookmark in your document, click the Bookmark Button, then select the bookmark in 
the list, click the Go To button at the bottom of the window. The Bookmark window closes and 
the cursor jumps to the location of the bookmark. 

6. To delete a Bookmark, click the Bookmark Button, select the bookmark in the list, then click the 
Delete button. The Bookmark is deleted and the Bookmark window closes. 

Notes:  

• It is possible for the Bookmarks window to show no bookmarks while a document is still 
loading.  

• If the document is long and has many bookmarks, the bookmarks may display slowly. 
Consider opening the document in Kurzweil 3000 and breaking the document into smaller 
parts, perhaps by chapter, using the Save Page Range feature. Then re-save the smaller 
documents to the Universal Library.  

• Some .kes files will not display bookmarks. Documents of the .opf, .bks, or .epub file types 
that were saved as .kes files will not display bookmarks. For example, if “Book about 
cats.bks” becomes “Book about cats.kes” in K3000, the bookmarks will not be seen in 
k3000+firefly. 

• Bookmark changes (adding or deleting) in k3000+firefly for files with a file extension of 
.epub and .bks,  will not be seen when the .bks and .epub files are opened in Kurzweil 3000 
Windows or Macintosh. 

Hiding Bookmarks. 
To hide Bookmark icons, deselect Show Bookmarks in the Document View menu’s Display Tools section.  

 

This setting will be in effect while the document is open. The icons will automatically display again when 
the Bookmarks button is selected in the next document with bookmarks that you open. 

Reading a Document. 
• Click the Play/Pause toggle to read using dual highlighting.  k3000+firefly highlights each word 

and Reading unit in two different colors. k3000+firefly moves the cursor forward by the Reading 
Unit option selected. By default, the Reading unit is set to sentence. 
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• Click the double arrows on the left of the Play/ Pause button to go back to Previous Reading 
Unit; click the double arrows to the right of the Play/Pause button to advance to the Next 
Reading Unit.  

• Click the Audible Reading toggle button to turn the sound on or off.  

• Open the Audio Options drop-down dialog and check or uncheck Skip Reading 
Headers/Footers. The default is checked (to skip). (Refer to the Documentation Preparation 
section of the Kurzweil 3000 online help and choose The Header/Footer Editor for topics on 
marking text as Header/Footer). 

Navigating Pages. 
• To navigate to the previous page or Next page, click the large Left Arrow or Right Arrow button 

on either side of the page display. 

 

• To go to a specific page, enter the page number in the Go to page box at the bottom left of the 
k3000+firefly window, and then click the Go button or press Enter. 
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Using References – Dictionary and Translation. 
The References drop-down menu allows you to look up a selected word (Dictionary) and translate 
selected text (Translation). 

 

Note:  You can also choose Picture Dictionary from the Dictionary drop-down menu. 

Looking Up Words. 
1. To look up a word, select a word, then click the References button then select Dictionary. 

  

 

2. In the Definition Window that opens, select a dictionary (Fifth Edition, Children’s, College 
Writer’s, and Picture). To hear the definition, use the Play / Pause on the toolbar. 

Notes:  

• For situations such as test taking, the TLC or teacher may have locked features. They can include 
Dictionary, Reading, Syllables, Brainstorm, Outline, Translate, Google Drive, Local Drive, 
Bubble Note Edit and Bubble Note Audible Reading. In those cases, those buttons are locked 
for that user wherever k3000+firefly is used. 
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• When Dictionary or Translate is selected on the Feature Lock tab, the buttons will also not 
display on the K3000 Read the Web toolbar. (See the Kurzweil 3000 online help topic “Using 
K3000 Read the Web as an Extension on Chrome or Firefox” for more information about Read 
the Web.) 

Translating Text. 
1. To find a translation, select a word or text, then click the References button and select 

Translation. Choose a language from the drop-down menu. Languages listed in bold have an 
associated voice.  

 

2. Click Translate.  

3. If the translation is in a language with a voice (shown in bold), click the Play / Pause button on 
the Toolbar to hear the translation. 

Note: Myanmar (Burmese) translation requires that the fonts, mmrtext.ttf and mmrtextb.ttf be 
available on your computer. These fonts are included in Windows 10, but may not be installed on 
earlier versions of Windows.  
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Highlighting Text in a Document. 
Use the highlighters to highlight selected text. In addition to the colors, you can also circle and cross out 
text. Use the eraser to erase the highlights, circles, and cross-out marks. Note that you cannot highlight 
text in .txt files (text files). 

To Highlight Text. 
1. Hover over the Highlighters button and select a color pen, a circle tool, or the cross-out tool from 

the list. 
 

 

2. In the document, drag-select the text you want to highlight, circle, or cross out. 
3. To highlight in a different color, click the Select button to end highlighting in the first color, and then 

repeat step 1. 
4. When you are done, click the Select button to end highlighting. 

To Erase Highlighting. 
1. Hover over the Highlighter button and click the Erase button. 
2. In the document, drag-select the highlighted (or crossed out) text you want to erase. 
3. When you are done, click the Select button to end the erase function. 

To Save Highlights. 
After highlighting, navigate to another page or click the Back to Library button. If you close the browser 
or leave the k3000+firefly website, you may lose the highlights for the session. 

Note:  If you highlight BKS or EPUB documents in k3000+firefly Reader, the highlights you added are not 
seen if you open those documents in Kurzweil 3000. 
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All about Sticky Notes and Text Notes. 
The Notes drop-down menu on the k3000+firefly toolbar displays the Sticky Notes and Text Notes 
options. Footnotes and Voice Notes added in Kurzweil 3000 Windows or Macintosh editions currently 
cannot be opened or edited in k3000+firefly. 

k3000+firefly supports adding, editing, formatting, word prediction, spell checking, translating, viewing, 
printing, deleting, and reading notes. 

Notes:   

• The k3000+firefly notes feature does not apply to KES files saved to your Universal Library in 
versions prior to the May 2015 version of k3000+firefly.  

• You can edit Sticky Notes and Text Notes that you add or edit in K3000+firefly. They will also be 
displayed in Kurzweil 3000 and the firefly iPad application. However, if  you add notes to BKS or 
EPUB documents in k3000+firefly Reader, the notes  you added are not seen if you open those 
documents in Kurzweil 3000.  

• The Note menu and the Zoom menu are not available for documents that can be edited. 

Adding a Note. 
1. Click the Notes button to display the Notes menu of options. 

  

2. Click the Add Sticky Note or Add Text Note option, and then click on the document where you 
want the note placed.  Click in another spot to add another note or click the Select button to 
end the Add Sticky Note or Text Note option.  
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3. Notice the Show button (default) next to the Add Sticky Note and Add Text Note options.  

• The Show button   indicates that Sticky Notes and/or Text Notes are visible. Click to 

display the Hide button .  

• The Hide button   indicates that Sticky Notes and/or Text Notes are hidden (not 

visible). Click to display the Show button . 

Note: If you upload a KES document that contains either type of notes, and you select the Show 

button  for both of the Notes Display options, they will be visible in k3000+firefly on the 
web. 

Using Word Prediction when Writing Sticky and Text Notes. 
Word Prediction can be helpful when you are writing notes. It is especially useful if the word you want 
to type is long and you are unsure of the spelling. As you type the first few letters, you will see choices 
and one of the words is likely to be the word you want. 

1. Open the Notes drop-down menu. 

 

2. Click the Add Sticky Note or Add Text Note to create a new Note. 

3. Click the Select button to end the Add Note option.  

4. Open the Tools drop-down menu. 
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5. Select Word Prediction. The Word Prediction dialog opens to the right of the document. 

 

6. Begin typing a word in your note (the letters will also appear in the field at the top of the Word 
Prediction dialog). Watch the list of choices appear as you type. If there are many, use the 
scrollbar to scroll the list. 

7. Click the word that you want to use. It will complete the word that you started typing in your 
note.  

8. Close the Word Prediction dialog when you have finished. 
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Spell Checking Sticky and Text Notes. 
You can spell check your Notes.  

1. With your Sticky Note or Text Note open, select Spell Check Sticky and Text Notes from the 
Tools menu. The Spell check dialog pops up to the right of the document. 

 

2. If it finds a questionable spelling, the word is displayed at the top (in this example, “childrun”). 
In the Suggestions section, you may see several choices.  

3. Select the word that you want as a replacement of the misspelled word, it immediately replaces 
the word. 

4. If you don’t see the correct word, type a word in the Replace field at the bottom of the dialog, 
then click the  

The word you select in the Suggestion list or enter in the Replace field replaces the misspelled word in 
the note. 
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Formatting a Note. 
1. Open the Note menu and notice the formatting options at the bottom of the menu. 

 

2. Select the Styling button (Bold and/or Italic). 

3. Select the Font Size from the drop-down menu.  

4. Select the Font Type from the drop-down menu.  

5. Select the Text Color from the drop-down menu.   

6. For sticky notes, select the Background Color from the drop-down menu (the default is yellow). 
Note that the background color for Text notes cannot be changed. 

Note: These formatting options do not apply to firefly on the iPad. Formatting that you apply in 
k3000+firefly will not be shown when viewing notes on the iPad. 
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Moving Notes. 
To move a note, click any edge of the note (top, side, or bottom) and drag the note to the location you 
want to move the note to, then release the cursor. The note will remain in the new location. Only one 
note can be selected at a time.   

 

Resizing Notes. 
You can resize the note by grabbing the triangle in the lower right corner and dragging it to the desired 
shape. 

Translating a Note. 
1. Select the text in the note that you want translated. 

2. Click the References button and select Translation. The Translate dialog opens with the text you 
selected in the note displayed on the left side of the dialog. 
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3. From the drop-down list on the right side of the dialog, select the language to use for 
translation. The languages in bold indicate that there is a voice associated with the language. 

4. Click the Translate button. The Translation is displayed on the right side of the Translate dialog. 

 

In this example, the translation is Spanish, and the default Spanish speaker voice is Rodrigo. Use 
the drop-down list to display other choices.  Note that not all languages have more than one 
speaker. 

5. If you want to replace the text in the note with the translation, select the translated text, copy it 
(CTRL+C) and paste it over the text in your note (CTRL+V). 

6. Close the Translate dialog when you have finished. 

Reading a Note. 
If you click on a note you can read the contents of that note.  They are not read as part of the page, so 
you must explicitly click on them and use the Read / Pause button in the toolbar to hear their contents. 
If the note has a scroll bar, you can use it to scroll through the contents of the note. 

Printing a Note. 
To print a Note: 

1. Open the Note menu and click Print Note. The cursor changes to a print selection icon ( ).  

2. Move the cursor to the note that you want to print and click on the note. Your print dialog will 
pop up.  

3. Select your printer and click OK. Click on another note to print or click the Select button to end 
the Print Note option. 
 

Note: If you are using the Edge browser, and you want to include Headers and Footers in your 
printed note, be sure to select ON for Headers and Footers in the Edge Print dialog. 
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Deleting a Note. 
1. Open the Note menu and click Delete Note, then click anywhere in the Sticky note or Text note 

to delete it.  
2. Click the Select button to stop the Delete Note option.  

Extracting Notes, Bookmarks, and Highlights. 
You can create rich outlines by assigning different indent values and prefixes to each of the Highlighter 
or Circle tool colors. For example, if you use the yellow Highlighter for main ideas and the green 
highlighter for supporting ideas, you might always want the green text to be indented when you extract 
it or print it. At the same time, you can extract Bubble Notes, Footnotes, Sticky Notes, and Text Notes, 
highlights, and bookmarks. 

1. Choose Extract from the Tools menu. The Extract dialog is displayed. 
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2. Click the OK button.  Or, if you want to change the prefix and the indent level for any of the 
highlight colors, click the Advanced button. The Advanced button displays a dialog that specifies 
Indents (in inches) and Prefixes by color. You can edit these fields. 

 

• If you are creating an outline or want to create a hierarchy of ideas in your summary 
notes, you can do so by customizing indents. Use the Indent fields to set indent values 
for any of the highlight colors. The text corresponding to each color is indented by the 
amount you specify. 

• Use the Prefix fields to specify auto-number or letter formatting for the text of each 
highlight color. 
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Note: the default settings produce standard outline numbering and formatting: 

Highlight Indent Prefix  Resulting Prefix 

Yellow 0 I. Uppercase Roman Numeral 

Green 0.5 A. Uppercase letter 

Blue 1 1. Arabic numeral 

Pink 1.5 a. Lowercase letter 

Orange 2 (1) Arabic numeral in parentheses 

Gray 2.5 (a) Lowercase letter in parentheses 

Red Circle 0   

Blue 
Circle 

0   

3. Accept the defaults or make desired changes, then click the OK button. 

In a short time the extraction file is displayed in the k3000+firefly Editor. The extraction file will 
identify Notes by the kind of note: Bubble Notes, Footnotes, Sticky Notes, and Text Notes; 
Bookmarks; and Highlights which will be displayed in outline form in the outline color used in 
the document. 

What you should see in the extracted document: 

• If you only extracted notes: the new document lists each note by type, the page on which it 
appears, followed by its contents. If there are multiple types of notes, they are presented in 
reading order. 

• If you only extracted Bookmarks: the new document lists each bookmark's description, in the 
order in which you specified in the Bookmark's dialog order. 

• If you only extracted highlighted text: the new document presents the text based on the 
default Custom settings: Yellow highlight as the main ideas with no indent or prefix, Green 
highlight as the sub-ideas, indented by .25 inches with no prefix. 

• If you had a combination of annotations: the new document lists the Page Number, followed by 
Notes, Bookmarks and Highlighted Text in reading order. 
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The Extraction file will be named by the book or file name, ending with _extractedoutline.kes, 
for example author_title_extractedoutline.kes. It will be located in your  
recently_opened_local_files folder. If you later add more bookmarks, notes and highlights to 
the same document, the extraction file will add a number, for example 
author_title_extractedoutline_1.kes, and author_title_extractedoutline_2.kes, etc. 

Notes: 

• Footnotes that are added to an image document or text based KES files in Kurzweil 3000 
Windows or Kurzweil 3000 Macintosh are not visible when that document is opened in 
k3000+firefly. However, they can be extracted along with Sticky Notes, Text notes, Highlights 
and Bubble Notes. Footnotes can be edited in Kurzweil 3000 Windows or Kurzweil 3000 
Macintosh, but not in k3000+firefly Reader. 

• Highlights can also be added and extracted from text based documents that are created or 
opened in the k3000+firefly Editor. 

All about Bubble Notes. 
Bubble Notes are typically created by a teacher. They can contain comments, directions for a task, or 
questions in a variety of formats: True or False, Radio Button, Checkbox, Match pairs or Text Answer. 
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Bubble notes are anchored to words in image documents and appear as a purple question mark. Bubble 
Notes typically appear automatically when you come across them in a document. 

 

When opened, they may have a cloud shape or a balloon shape. 

Bubble Notes can be created, edited, viewed, and answered in k3000+firefly image documents. Bubble 
notes added to KES image documents in Kurzweil 3000 Windows and Macintosh can also be edited, 
read, and answered in k3000+firefly. Bubble notes are not visible when using the firefly iPad app.  

Note: During test-taking situations, a Teacher may lock Bubble Note Edit and Bubble Note Audible 
Reading. 
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Adding a Bubble Note. 
1. In the open image document, click near or on a word where you want the Note to open. 
2. From the Tools menu, choose Add Bubble Note. 

 

3. The Bubble Note dialog appears. By default, the selected note’s Appearance is Balloon and the 
Size is Small. 
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4. Select the desired Appearance option from the Shape drop-down menu: Balloon or Cloud, and 
select the size from the Size drop-down menu, Small or Large. 

5. Select the Open Options. You can choose: 

• Open while reading. Enabled by default; opens and reads Bubble Notes as students read the 
document. Deselect this if you want to provide students with an uninterrupted reading 
session in which the Bubbles do not open and read. 

• Open before unit is read. Opens Bubbles before it reaches the reading unit in which you’ve 
anchored a Bubble. For example, suppose the reading unit is set to Line, K3000+firefly 
would open the Bubble embedded in the line before reading the line. 

• Open when word is read. Opens Bubbles after it reads the word near the anchor. 
• Open after unit is read. Opens Bubbles after it reaches the reading unit in which you’ve 

anchored a Bubble. For example, suppose the reading unit is set to Paragraph, K3000+firefly 
would open the embedded Bubble after reading the paragraph. 

6. Select the Question Options. You can choose: 

• No Question (informational/instructional, for reading only). 
• True or False (radio buttons where only one answer can be selected from two choices). 
• Multiple Choice (check boxes where more than one answer can be selected, or radio 

buttons where only one answer can be selected from several choices). 
• Match (two lists of items where items are paired from one list with items on the other 

list). 
• Text Answer (one-line text box for shorter answers or multi-line text box for more 

detailed answers).  

7. When you have finished, click Save. You will see the Bubble Note anchor. 

 

8. Click the question mark and the Bubble Note will open and automatically be read aloud.  
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Using Word Prediction. 
You can use Word Prediction when working in a Bubble Note. 

1. Add or open a Bubble Note. 
2. Open the Tools menu and click Word Prediction.  

 

3. Start typing in your Bubble Note. Word Prediction works just like it does with Sticky Notes and 
Text Notes. See Using Word Prediction when Writing Sticky and Text Notes for details. 

Spell Checking a Bubble Note. 
When you have finished writing or editing a Bubble Note, you can Spell Check the note. With your 
Bubble Note open, open the Tools menu and click Spell Check Bubble Note. The Spell Check dialog 
opens. It works the same way as it does for Sticky and Text Notes. See Spell Checking Sticky and Text 
Notes for details. 
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Editing a Bubble Note. 
Teachers may lock the Bubble Note Edit feature for students before a test to prevent students from 
editing a bubble note's contents. See the section To Use Feature Locks to Disable Features in “User and 
License Management” for instructions. If Bubble Note Editing is locked, students will not see Edit in the 
Bubble Note Anchor; only the question mark is visible. They will, however, be able to read the note* and 
answer any questions and save answers, but won’t be able to edit the note.  

*If Teachers also locked Bubble Note Audible Reading, the student will be able to see and read the note 
to themselves, but it won’t be read aloud. 

To edit a Bubble Note: 

1. Hover your cursor over the Bubble Note Anchor to display the Edit command. 

 

2. Click Edit. The Edit Bubble Note dialog opens. 

 

3. Make any changes to the Bubble Note you want – Shape, Size, Open Options, and Question 
Options. When you have finished, click Save. Note that you can also use this dialog to Delete the 
Bubble Note. 

4. Note that you can use Word Prediction when you are editing a Bubble Note, and you can Spell 
Check it when you have finished. 
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A Note about the ampersand character (&) and key accelerators: While creating multiple choice items 
in the Bubble Note dialog, the ampersand character (&) may be inserted before the letter you want for a 
key accelerator. In the example above, there is an & before the letter “A” in “Astronomer,” the letter 
“M” in “Meteorologist,” and the letter “P” in “Physicist.” A student taking a test in Kurzweil 3000 can 
press the ALT plus the character key for the underlined letter in the desired item to select it. For 
instance, pressing ALT+P would select the radio button for “Physicist.” This is useful for students who 
have special needs or who prefer to use the keyboard.  

Although ampersands preceding multiple choice questions can be added and edited in k3000+firefly for 
the web, they do not create the underlined letter for keyboard selection use in k3000+firefly for the 
web, firefly for the iPad, or Kurzweil 3000 Mac Edition; they only work in the Kurzweil 3000 Windows 
Edition. See the Kurzweil 3000 Windows Edition online help topic “Adding Optional Accelerator Keys for 
Multiple Choice Items” for more details on how this feature works. 

Hiding Bubble Notes. 
Bubble note icons can be hidden in a document by deselecting Show Bubble Notes in the Document 
View menu Display Tools section.  

 

This setting will be in effect while the document is open. The icons will automatically display again when 
the next document with bubble notes is opened.  
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Printing a Page. 
To print a specific page, go to that page and click Print Page from the Tools drop-down menu.  

 

Your print dialog will pop up. Select your printer, edit the property settings if necessary, and click OK to 
print. 

Notes:  

• If you are using the Edge browser, and you want to include Headers and Footers, be sure to 
select ON for Headers and Footers in the Edge Print dialog. 

• Some browsers may print the selected page onto two pages. To print the information on one 
page, adjust the zoom setting in k3000+firefly to a value below 100%, and then select Print Page 
again. 

Creating a PDF. 
To create a PDF of a document you have open, click Create PDF from the Tools menu. When the PDF has 
completed, it will appear in a PDF reader in your browser. From the PDF Reader you can download the 
file to your computer. The Create PDF tool will create up to 10 pages.  

Notes:  

• You may need to allow pop-up windows or disable ad blockers in your browser to create a pdf. 
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• If your document is longer than 10 pages, after you have saved the first PDF, display the page 
following the last page in the PDF (page 11, for example), and choose Create PDF again. Repeat 
as needed. The PDF save will always begin on the page you have displayed. 

To download the PDF from the Browser’s PDF Reader. 
The steps will vary depending upon your browser. Examples using Firefox and Chrome have been 
provided here. 

1. In the upper right corner of the PDF Reader, click the download button. 

 
Firefox PDF Reader  

 
Chrome PDF Reader  

2. If you are using Firefox, the Opening document.pdf dialog displays. 

 

• It will show the default name, Document.PDF and Save File is selected. 
• Click OK and it will be saved in your default download folder – usually named Download. 
• If you have downloaded more than one PDF it will append a number after the name 

(Download(2).PDF, Download(3).PDF, etc.). 
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3. If you are using Chrome, the Save As dialog displays with a default name in the File name field: 

 

• The filename will be a long string of letters and numbers. Select (highlight) the file 
name. 

• Enter a more meaningful name in the File name field. 

Test Taking for Students. 
k3000+firefly  offers a variety of ways to make test taking a comfortable and successful experience. You 
can: 

• Adjust reading speed. 
• Mark answers using either Color Highlighters or Circle Tools. 
• Proofread by hearing the test read back aloud. 
• Respond to Bubble Note questions. 

Preparing for Tests. 
How can you do well on a test? The most important key to taking tests is preparation. 

Here are some suggestions for preparing for tests: 

• Open the material that you will be tested on. 
• Use k3000+firefly Notes, Color Highlighters or Circle tools as you read. 
• Explain the topic and its details to a friend. 
• Change a fact into a question the teacher might ask on a test, then use k3000+firefly Notes to 

write and insert the questions into the material. 
• Use the k3000+firefly Reference tools to look up words. 
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• Pull your Notes and highlights together using the Extract feature to create study aids (see 
Extracting Notes, Bookmarks, and Highlights for details). 

• If you know that there will be an essay question, practice. Create some questions and answer 
them. Use k3000+firefly Editor to write. Word Prediction can help you with spelling. Have 
k3000+firefly read back what you write so you can self-correct. 

• Practice using Kurzweil 3000 test-taking features. 
• If you know that you will be allowed to use k3000+firefly to take your test, ask your teacher 

what k3000+firefly tools and features will be made available to you. Then practice using those 
features.  

In the K3000 Sample Documents folder, there are several tests that you can open in the Universal 
Library and then use to practice using test taking features in k3000+firefly. See Opening Local Files 
from Your Computer. 

This example shows the Language_Arts.kes.  Fill in the Blank test in the Test Taking subfolder of 
K3000 Sample Documents. 
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In the K3000+firefly Universal Library Samples folder, there are subfolders with several documents that 
have test questions. This example shows Bubble Note questions on the last page in 
It_takes_a_world_to_make_a_shoe  from the passport_reading_journeys subfolder. 

 

You can copy any of these documents to your Universal Library folder, read them, and practice 
answering the questions. See Copying Files. 

Different Types of Test Questions. 
There are a number of typical elements that can appear in tests: 

• Multiple Choice. 

• Fill in the Blanks. 

• True or False. 

• Match. 

• Essay Response. 
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Tests using Bubble Notes. 
• Some Bubble Notes provide a Text Box for you to type your answer. For longer answers, the 

Text box would be larger. 

 

• To select an answer in a True or False note, simply click True or False. When only one answer 
can be selected the answers will use radio buttons. 

: 

• Multiple Choice also use radio buttons. Choose the correct answer from the list. 
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• Another Bubble Note type asks you to match answers: 

 

1. In the left column, click the item you want.  
2. Then click on the correct match in the right column. 
3. Repeat until all pairs are matched. 
4. Then click Save to accept your answer and close the Bubble Note. 

Note that answers added in bubble notes in k3000+firefly can also be viewed in Kurzweil 3000 Windows 
and Macintosh. They are not visible in firefly for the iPad. 

Using the k3000+firefly Editor. 
In addition to reading documents in k3000+firefly, you can edit existing DOC, DOCX, RTF, TXT, and some 
KES documents using the k3000+firefly editing features. You can also create new documents using the 
Brainstorm, Outline, and Draft features on the Write menu combined with the k3000+firefly editing 
features.  

Editing. 
1. Navigate to the folder where the RTF, DOC, DOCX, or TXT document is located. Be sure that you 

have write access to that folder. If you created a KES file using the New Draft feature in Kurzweil 
3000 or the Write features in k3000+firefly, it also can be edited. KES Image files cannot be 
edited. 

2. Click the document name. The document is opened in the Editor in the blank area beneath the 
buttons. The Editing window displays formatting options as well as drop-down menus. 
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The editor works like most editors. You can use the buttons and drop-down menus to format 
the text as well as using keyboard shortcuts (e.g., CTRL+B for bold). Note that the buttons 
available depend on the file type. 

Character and Paragraph Formatting. 
• The first three buttons are the Font Style buttons. Select a word or words and click B for 

bold, I for Italic, U for Underline.  

• The second three buttons are the Paragraph Alignment buttons: Align Left, Align Center, 
and Align Right. 

• Next are the Font choices, and Font size drop-down menus. Click the down arrow to display 
the choices. 

• To the right of the drop-down menus are the Undo and Redo buttons. If you haven’t used 
the Undo button, the Redo button is grayed out. 

The Edit menu. 
The Edit drop-down menu displays the features available when you are creating or editing a document. 
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Spell Checking. 
1. To spell check your document, choose Spell Check from the Tools drop-down menu. The Spell 

Check dialog is displayed. 

 

If it finds a questionable spelling, the word is displayed at the top (in this example, “nife”). In the 
Suggestions section, you may see several choices.  

2. Select the correct spelling of the word (in this example, “knife”). The word you select replaces 
the misspelled word in the document. Note: You can also click the sound button to hear the 
word pronounced. 

3. When you have finished, click the X at the top right corner of the Spell Check dialog to close it. 

Word Prediction. 
The Word Prediction feature is helpful for completing words that you may not know the spelling for, or 
for speeding up typing a long word. 

1. Choose Word Prediction from the Tools drop-down menu. The Word Prediction dialog is 
displayed. 

2. Start typing. As you type, the letters are displayed in a field at the top of the Word Prediction 
dialog and word predictions are listed below that field. 
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3. Click the predicted word that best completes what you started typing. The word you select in 
the list replaces the partially typed word in your document. 

4. To end Word Prediction, click the X at the top right corner of the Word Prediction dialog. 

Background Color. 
You can select a background color for viewing documents in the Editor window. This includes New Drafts 
created in Kurzweil 3000 or k3000+firefly, or when a RTF, TXT, DOC or DOCX is opened. This feature is 
useful in test-taking situations. The background color you select is saved as a preference for the 
k3000+firefly web app. Note that a separate preference is saved for Kurzweil 3000. 

Changing the background color does not change the actual color of the document. This is for viewing the 
document in the Editor window.  

If you select Gray, Slate, or Granite as a background color, it’s best to choose a contrasting color if using 
highlighting. Otherwise it may appear that the highlighting is missing  

With some browsers if Windows high contrast display themes are being used, the background colors in 
the Editor window cannot be changed. 

Save your Document. 
Be sure to save your changes frequently. Just click the Save button on the k3000+firefly Reader toolbar. 
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The Writing Path. 
In addition to editing existing DOC, DOCX, RTF, TXT and some KES documents, you can create new 
documents using the Write menu options and k3000+firefly text editor features.  

The Writing Path in K3000+firefly consists of an integrated set of tools that support and correlate with 
the stages of the writing process.  

Starting Points for Writing. 
There are several starting points for Writing. You can start a New Brainstorm, Outline, and 
Draft by choosing from the Write menu on your Library Page.  

 
 

All three parts of the Writing Path are views of a single text document. This means you can: 

• Go back and forth between the Brainstorm and Outline views. 

• Because Brainstorm and Outline share the same information, each view preserves 
the content and organization from the other view, while presenting the information in 
a different format. Changes in one view are reflected in the other view. 

• Go from Outline to Draft. You can create a Draft from an existing outline.  

Use the Starting Points table below to determine the best starting point for your writing 
style. 
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Starting Point for 
Writing. 

Description. Switching Views. 

Choose New Brainstorm from 
the Write menu.  

Brainstorm is a graphic 
organizer that lets you visually 
organize your thoughts and 
create a "diagram" or graphic 
plan for your writing. 

 

Opens a new Brainstorm, 
graphic organizer file. 

This is a good starting point if 
you like to visualize your 
thoughts. 

You can use the Brainstorm 
tools to quickly get your 
thoughts out and just as quickly 
organize them. 

Click Outline view and you have 
an outline ready to use or 
submit to your instructor. You 
can even work in both views, 
switching back and forth. 

 

Brainstorm From Template. 

K3000+firefly includes several 
templates in the Universal 
Library. The templates contain 
instructions and organization in 
graphic format. 

Choose a template and copy to a 
folder that you have write access 
to. 

Opening the copied template is 
a good starting point if you 
require guidance as you 
compose your piece, and you 
like to visualize your thoughts. 

You can use the Brainstorm 
tools to edit and reorganize 
your thoughts. 

Click Outline view and you have 
an outline ready to use or 
submit to your instructor. You 
can even work in both views, 
switching back and forth. 

 

Choose New Outline from the 
Write menu. 

Outline lets you jot down and 
organize your thoughts into a 
text-based, hierarchical writing 
plan. 

 

Opens a new Outline file. 

Use this as a starting point if 
you like to use text-based 
organization for your thoughts. 

You can use the tools to move 
Topics around and restructure 
the outline as you work. 

Click Brainstorm view if you 
want to see your outline in 
graphic format. You can work in 
both views, switching back and 
forth. 

 

Draft from Outline. 

Opening a draft from the Outline 
tool opens the draft including 
the outline. 

Opens a draft window including 
the outline so you can expand 
your outline with explanatory 
text.  

If you start here, you can switch 
to Brainstorm and Outline 
mode.  

 

Choose New Draft from the 
Write menu. 

Draft is where you go through 
iterations of your document, 
writing, revising and editing.  

Opens a new/empty .kes text 
file. If you like to write in free-
form or stream-of-
consciousness style, this may 
be a good place to start. 

To organize/re-organize, use 
Copy/Cut/Paste. 

If you start here, your draft is 
not connected to the 
Brainstorm and Outline modes.  
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Creating Brainstorm Diagrams. 
k3000+firefly Brainstorm is a graphic organizer that is designed to help you collect your ideas quickly, 
and organize your thoughts visually into a "diagram." You can use all the text editing tools available in 
the k3000+firefly Editor window on selected text.  You can hear the selected text using the Read button. 
Note that Brainstorm diagrams created and saved in k3000+firefly can also be viewed in Kurzweil 3000 
Web License Edition, but not viewed in firefly on the iPad. 

Many writing and editing features are available to you while you are working in the Brainstorm and 
Brainstorm Notes: 

• Text editing functions, including Undo. 
• All reading functions, including Speak as Typing. 
• Word lookup. 
• Translation (translation doesn’t automatically replace the selected text; copy and paste the 

translated text onto the selected text in the Brainstorm to replace it). 
• Word Prediction. 
• Spell Checking. 

Below is an example of a simple Brainstorm diagram. 
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There are two ways to create a Brainstorm diagram:  

• Copy a Brainstorm Template from the Library page and paste it in one of your folders that you 
have write-access to, then open it in the k3000+firefly Editor. (See Copying Files for details on 
using the Copy and Paste buttons.) The Editor displays the Brainstorm Template and the 
Brainstorm Palette. 

• Select New Brainstorm from the Write menu. The Editor opens displaying one “thought” and 
the Brainstorm Palette. 

 

The Brainstorm Editor and Tools Palette. 
When you open the Brainstorm window, a Brainstorm palette appears along the left side of the window. 
Use the scrollbar to view all the options.  Hover your cursor over each tool. You’ll see a tooltip defining 
the tool. 
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Creating Thoughts. 
Initially when you first open a New Brainstorm, one thought is displayed, titled Main Idea. You can use 
this as a starting point.  
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1. Click inside the shape and start typing to add a description to your Thought. 
2. Use the text editing buttons to edit the font, font size, and font style of the selected text. 

 

3. Use the Text Color button to change the color of the selected text. A color chooser window is 
displayed. 

 

4. Select a color, then click the choose button. The selected text will be displayed in the color you 
chose and the color chooser window is dismissed. 

Change the Shape Properties. 
You can change the properties of the shapes, including shapes, font, font color, size, and color of the 
diagram background.  

1. Shape: Select an existing shape (an oval, for example). Click one of the other shape buttons 
(rectangle, for example). The selected shape changes. 

2. Shape Color: Select a shape and click the Shape Color button. The color chooser window is 
displayed. Select a color then click the choose button. The shape color changes and the 
color chooser window is dismissed. 

3. Background Color: Place your cursor outside the shapes and click the Background Color 
button. The Color Chooser window is displayed. Select a color and then click the choose 
button. The background color changes and the color chooser window is dismissed. 

4. Text: Select the text. Use the text editing buttons to change the font, font size, and font 
type.  

5. Text Color: Select the text and click the Text Color button. The Color Chooser window is 
displayed. Select a color and then click the choose button. The selected text is changed to 
the color you chose. 
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Use Quick Takes to rapidly create sub-thoughts.  
1. Select a shape, then click Quick Take. A shape is added with Instructions to Add Text and press 

Return. 

 

2. In the Quick Takes Instruction box, type a name for the sub-thought, then press the Return key 
on your keyboard. A sub-thought is added and linked to the Thought.  Another Quick Takes box 
is displayed.  

 
3. To add another sub-thought, type a name and press Return. The next sub-thought is added and 

linked to the Thought.  Another Quick Takes box is displayed.  
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4. Continue adding until you have added all the Sub-thoughts you want. Click outside the Quick 
Takes box and it is dismissed. 

Linking Thoughts using the Link button. 
If you add a Thought or a sub-thought and want to link it to an existing one use the Link button 

1. First Select the Thought to link from, and click the Link button. A link “cursor” is attached to the 
selected Thought. 

 

2. Drag the link to a Thought or Sub-thought you want to link to and release. The two are linked. 

Selecting one or more shapes. 
Select a shape by clicking on it. You can drag and drop it to another spot on the diagram. To select 
multiple shapes, click and drag around the shapes you want to select. You’ll see a dotted line 
surrounding the shapes as you drag.  
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When they are all inside dotted line, release the cursor and each of the shapes will be selected. 

 

Now that they’re selected, you can change the shapes or colors of the selected Thoughts 

Arrange your Thoughts and Sub-thoughts. 
After you have created several Thoughts and Sub-thoughts you may want to rearrange them. The 
quickest way is to use the Arrange button. 
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1. Click the Arrange button. Your Thoughts and Sub-thoughts are aligned and arranged. 

 

Adding a Note to a Thought. 
1. Select a Thought, then click the Show/Hide Notes button. A box is displayed in which you can 

write a note. Additionally, a Brainstorm Note icon will appear in the upper right corner of the 
Thought it is attached to. 
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2. To hide a note, select the Note icon. The note is hidden. To show the note, click the Note icon 

again. 
3. You can edit the note text by selecting the text and using the text tools. 

 

4. To delete a note, select the text in the note, and press the delete key on your keyboard (or 
CTRL+X), then click the Note icon. The note is deleted. 

Setting and Applying Defaults. 
If you like a shape, a fill color, or text color (for example a green oval with black text) you can make 
those settings be a default for this Brainstorm diagram by selecting the shape and clicking the Set 
Default button. You can then select other shapes and click the Apply Default button, and the shape, 
color, and text color will change to the default you set (in the example shown above, a green oval with 
black text). Note that the default you select will only apply to the current Brainstorm diagram. 

Creating a New Outline. 
Kurzweil 3000 Outline feature lets you organize your ideas into a standard outline format that you can 
follow as you write. You can use all the text editing tools available in the k3000+firefly Editor window on 
selected text. You can hear the selected text using the Read button. Note that Outlines created and 
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saved in k3000+firefly can also be viewed in Kurzweil 3000 Web License Edition, but not viewed in firefly 
on the iPad. 

Many writing and editing features are available to you while you are working in the Outline and Outline 
Notes: 

• Text editing functions, including Undo. 
• All reading functions, including Speak as Typing. 
• Word lookup. 
• Translation (translation doesn’t automatically replace the selected text; copy and paste the 

translated text onto the selected text in the Outline to replace it). 
• Change background color. 
• Word Prediction. 
• Spell Checking. 

The Outline Editor and Tools Palette. 
Initially when you first open a New Outline, one thought is displayed, titled Main Idea. You can use this 
as a starting point.  

 

You will also see the Outline tools palette along the side of the Editor. The palette allows 
you to: 

• Create Topics or key ideas, Subtopics as well as supporting details. 

• Quickly re-organize the Topics and Subtopics. 

• Switch from a variety of different prefix labels, such as Roman Numerals and Legal. 
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• Add Notes to hold additional information and elaboration, such as quotes and source 
information. 

Hover your cursor over each tool. You’ll see a tooltip defining the tool. 

 

Adding Topics and Subtopics. 
To add a Topic: 

1. Select the Topic. 
2. Click the Add Topic button.  

A Topic is added beneath the selected Topic. 

To add a Subtopic to a Topic: 

1. Select the Topic you want to add a Subtopic to. 
2. Click the Add Subtopic button. 

A Subtopic is added beneath the selected Topic. 

To add another Subtopic to a Subtopic: 

1. Select the Topic you want to add another Subtopic to. 
2. Click the Subtopic button. 

Another Subtopic is added to the selected Topic. 
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Note:  You can also: 

1. Select the Subtopic you want to add a Subtopic to. 
2. Click the Add Topic button. 

Another Subtopic is added beneath the selected Subtopic. 

Reorganizing Outline Topics. 
There are a number of ways to re-organize Topics in Outline view: 

• Move a Topic anywhere by Cutting/Copying and Pasting. 
• Move a Topic up or down in the order by using the Move Up or Move Down buttons. 
• Change the Topic level up or down by using the Promote or Demote buttons. 

At any time, you can undo an action by pressing CTRL+Z. 

Adding a Note to a Topic. 
1. Select the Topic or Subtopic that you want to attach a note to. 
2. Click the Note button. A Note icon is displayed beneath the selected Topic or Subtopic. 
3. Type the note text in the space provided after the note icon. 
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4. Click the Note icon to hide the text. 

 

Deleting Topics and Subtopics. 
1. To delete a Topic or Subtopic, select it. 
2. Click the Delete button (trash can icon). 

Note: If the Topic or Subtopic contains a note, the note will also be deleted. 

Switching the Outline View to its Brainstorm View. 
1. To see your Outline View as a Brainstorm Diagram, choose Brainstorm from the Views menu. 

 
2. Click the Arrange button, if necessary. 

Notice the Note icons. You can click them to display the text. Click again to close. 
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Creating an Outline from a Brainstorm Diagram. 
Because Outline and Brainstorm are both views of the same Kurzweil 3000 text file, and share the same 
information, you can go back and forth between the text-based outline and the graphics-based 
Brainstorm diagram using the Views menu.  

 

To create an Outline from a Brainstorm Diagram: 

1. Open your Brainstorm Diagram (if it is not already open). 
2. Click Outline from the Views menu. 

Your Brainstorm Diagram is displayed in Outline form: 

 

The hierarchy you created in the Brainstorm view is preserved in the Outline view. 

Any changes you make in this view will be reflected in the Brainstorm view. You can easily switch back 
and forth using the Views menu. 
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Going from Outline to Draft. 
When you are ready to go from Outline to start writing in a Draft, click the Create Draft button in the 
Outline Palette. The Outline view changes to Draft view with the outline text as content, ready for you 
to begin editing and turning into full sentences and paragraphs. Also, the Outline Palette is no longer 
showing in Draft view. 

Creating a New Draft. 
In addition to editing existing DOC, DOCX, RTF, TXT and some KES documents, you can create a new 
document using the Write menu and k3000+firefly text editor features. (See Using the k3000+firefly 
Editor for details about using the Editor.) 

1. To create a new document, navigate to a folder that you have write access to and click the New 
Draft from the Write menu. 

 

2. A New Draft name dialog is displayed. Give the draft a unique name. If the name is more than 
one word, separate the words with an underscore. 
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3. Click Create. The k3000+firefly Reader /Editor page will open showing the Edit Toolbar beneath 
the Reader Toolbar.   

4. Create your document in the blank space beneath the toolbar.  

5. Use the Character and Paragraph formatting tools to format your document. 

6. To enable Word Prediction and Spell Check, select from the Tools drop-down menu.  

7. Be sure to save your changes frequently. Just click the Save button on the k3000+firefly Reader 
toolbar. 

 

8. The document is saved as a KES file. You can open this file again if you want to edit further. 

Note that when you create a New Draft, there won’t be associated Brainstorm Diagrams or an 
Outline. 
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